Dr. Lu Hired as Oilseed Molecular Geneticist

We would like to welcome Dr. Chaofu Lu to our department. He comes to us from the Washington State University in Pullman. Following are some of his thoughts on his new position.

"I arrived in the last week of August, just in time to put my son in school. Kevin told me that they have about 90 new students in Longfellow Elementary, so I guess we could be among the couple of thousand people choosing to live in Bozeman. Kevin is now in 5th grade, but his brother Alan just missed the school cutoff and has to stay in daycare for another year! My wife, Jinling, likes this town very much. You might be lucky to see her around if I can persuade her to help me in the lab before she finds a job. She is also an experienced biologist.

I am working on novel fatty acid accumulation in oilseeds. Right now I use Arabidopsis as a model plant, but the results can easily be transferred to any real oilseed crops because Arabidopsis has a similar fatty acid profile to many major oilseed crops. My PhD in Genetics was a joint venture between the Chinese Academy of Science in Beijing and Purdue University in West Lafayette, IN. I worked for many years on molecular mapping of rice, especially quantitative trait loci. I started working on Arabidopsis when I was hired at the John Innes Centre in Norwich, England, and have been in the plant lipid area ever since. Before coming here, I was a postdoc in John Browse’s lab at Washington State University. I was working on genetic engineering of ricinoleate, a kind of hydroxy fatty acid found mainly in castor bean, in transgenic Arabidopsis. Castor oil has numerous uses, ranging from industrial products to cosmetics (www.castorworld.com). I will continue this project and hopefully will produce ricinoleate in some oilseed crops.”

We would also like to welcome the following faculty, their staff and students from the former Entomology Department to our department.

Florence Dunkel, Associate Professor

Florence Dunkel received her B.S. in Zoology, M.S. in Zoology (second major in secondary teaching) and Ph.D. in Entomology with a minor in Zoology from the University of Wisconsin-Madison. Her first two years were at Downer College, now part of Lawrence University, Appleton WI. She has received the AAUW Marie Curie Postdoctoral Award, the Lindbergh Award, the National Academy of Sciences Visiting Scientist Award to the People’s Republic of China, the Distinguished Achievement Award of Lawrence University, and the Andersons Research Award (NC213) for management of grain quality and security in world markets. She has also received 2 regional teaching awards from the Entomological Society of America. Her research area was initially with Protozoa, freshwater, then entomopathogenic protozoa and insect commensals. Since 1986, she has conducted research on natural
(botanical) and other non-synthetic, non-commercial pest management techniques for insects. After 17 years at the University of Minnesota-Twin Cities, Dunkel took the headship of Entomology at Montana State.

Since 1989, Dunkel has taught ENTO 102, Insects and Human Societies. This is now a University Core Course in Contemporary Issues in Science. This course was a natural response to her extensive collaborative research programs that seemed to blossom in China, Korea, Morocco, Rwanda, and Mali. It was Dr. David Sands, during an introduction in 1989, who first explained why this internationalization had happened to Dunkel. “It is an obvious result of Dunkel’s growing up in a tri-lingual household. She was immersed in a cross-cultural environment from the beginning.” Dunkel is the first person in her father’s and mother’s family to speak English as a first language.

Dunkel is currently the project investigator for 3 collaborative grants with Malian institutions, primarily the University’s Institute of Agriculture and the counterpart of the USDA. She launched the Mali undergraduate “extern program” in 2000 at MSU after 6 years of collaborations with the IPM CRSP-Mali. Now this system of undergraduate mentorships in Mali is underway at partner institutions, Virginia Tech, University of St. Thomas (St. Paul), Chief Dull Knife College (MT), and UC-Davis. She and the MSU faculty also partner with the same institutions to provide training for the Malian scientists and professors who are launching the Agribusiness Entrepreneurial Incubator Center of Mali. Do greet these seven amazing Malians when you see them on campus.

Dunkel also teaches ENTO 480 Natural Products and ENTO 500 Plant-Insect-Human Interactions. Content for these courses is strongly influenced by her collaborative research with Malian scientists.

Free times are occupied with her 3 children, 4 grandchildren, and 5 step-grandchildren and their parents. With her husband, Robert E. Diggs, she enjoys working on grants and being a subsistence farmer (raising all their own vegetables and some fruit, organically) and, in the past, raising dairy goats. Dunkel also enjoys playing the piano and cross-country skiing.

Judee Mussel-Aziz, Research Associate (Dunkel)

Judee is working as the project manager for the Ag Biotech grants Florence has with government and university institutions in Mali.

Judee worked for 15 years with the U.S. Department of Commerce in Washington D.C. providing export marketing assistance to U.S. companies.

She has 2 young girls and many, many pets. Her hobbies include gardening and art.

Matthew Broughton, Graduate Student (Dunkel)

Officially a grad student as of Spring 2005, after non degree work for two semesters. I am the youngest of three boys in my family. My father was a career Marine with 36 years of active duty. His job had us move all over the country and even to Europe for 4.5 years. My parents moved to Bozeman 17 years ago and live in the Bridgers. I have numerous interests and hobbies. I snowboard, mountain bike, rock climb, flyfish, golf and many other Montana pass-times. I am also a semi professional musician. I have played the violin since I was a little kid and now teach violin/fiddle and mandolin lessons. I have been a private music teacher for three years and love every
minute of it. I am also the fiddle player in a local bluegrass band called "Sticky Fingers" and we perform on a regularly sporadic schedule.

I am working towards my Master's in Entomology, with my Thesis topic being Postharvest Varietal Resistance to Insect Feeding of Northern Hard Wheats. I plan to defend in the Spring of 06 and have a final class in the Fall of 06.

Broughton Receives Award
We also want to let you know that Matt Broughton has just received a national Entomological Society of America Award, the Stan Beck Fellowship for 2005. This is an award set aside for students with disabilities. Stan Beck was a really well known insect physiologist and served on Florence Dunkel’s Ph.D. committee. Congratulations Matthew!

Mike Ivie, Associate Professor

Mike started at MSU in 1985 in the Department of Entomology. He is the Curator for the Montana Entomology Collection and the current President of the Entomological Society of America. His current research focus is beetle systematic and faunistics.

Rich Hurley, Affiliate Professor

I am currently an Affiliate Professor and have been the Associate Curator of the Montana Entomology Collection (MTEC) at MSU (Entomology) since 1996. Previously, I have been a Biology Professor at Humboldt State University in Arcata CA, taught Entomology, General Zoology and Behavior for 30 Years. My research interests include Systematics of Long Legged Flies, (Diptera:Dolichopodidae) and currently Coach for (former) Entomology Linnean Team.

I have been the coach of the ex-Entomology Linnean Games Team. They won a regional contest in California in March and they are going on to the national contest in Fort Lauderdale, Florida in November. In my free time, I enjoy collecting and sorting insects (imagine that!)

Ian Foley, Graduate Student (Mike Ivie)

My name is Ian Foley, and I am originally from Milwaukee, WI. I have been attending MSU for a year and a half working on my master's degree with Dr. Michael Ivie on beetle systematic. I recently spent a month on the island of Montserrat, B.W.I. working on an inventory of the beetles of that small volcanic island. My thesis work is on a small group of very cool beetles commonly called "Irenelids". I have a bachelor’s degree in Biology from North Central College in Naperville, IL.

Sardis Medrano-Cabal, Graduate Student (Mike Ivie)

My name is Sardis Medrano-Cabal. I'm from The Dominican Republic. My undergraduate degree is in Education with focus on Biology and Chemistry. I'm in the Fulbright-OAS Ecology program for the Caribbean; Currently I am working on my Master's degree in Entomology with Dr. Michael A. Ivie on beetle systematic. My research interest is the beetles of the genus Phyllophaga. My thesis dissertation is a Taxonomic review of the genus Phyllophaga from Hispaniola, Puerto Rico and the Virgin Islands. I will be documenting more than 80 described and undescribed species of June Beetles from this area.
Sue Blodgett, Associate Professor

Sue started at MSU in 1994 in the Dept of Entomology and has a 50/50 research/extension split. Her current appointment is 65% Animal and Range Science and 35% PSPP. Sue received her M.S. (1987) and Ph.D. (1989) in Entomology at Kansas State University, M.S. degree from Cornell University Department of Horticulture and her B.S. degree from Syracuse University. Following completion of her graduate work she was employed by the University of California Statewide Integrated Pest Management Program as the IPM advisor for the North Coast. She was then employed by Colorado State University, Dept of Entomology before joining the Department of Entomology faculty at Montana State University in 1994.

Dr. Blodgett’s research program goals include developing pest management solutions based on knowledge of arthropod behavior, ecology and population dynamics to benefit Montana producers. Alfalfa and small grain pests have been emphasized in her program with her work on alfalfa weevil, wheat stem sawfly, and cereal leaf beetle. She has successfully secured funding from commodity groups and competitive federal programs administered by the USDA including Western Regional IPM, USDA-NRI, and Western Regional SARE. Her research has emphasized collaboration among the pest disciplines and has provided leadership for IPM activities.

Dr. Blodgett has served as chair of regional IPM and cereal aphid research committees, has chaired Section F of the Entomological Society of America and served in various capacities on regional and national professional organizations. She serves as faculty advisor to Gamma Bet Phi honor society at MSU.

Sue is married to Andy Lenssen and they have a daughter Susie Lenssen who is entering MSU this fall and will not be majoring in entomology.

2005 Annual American Phytopathological Society Meeting– Austin TX (July 30th-August 3rd)
By Alan Dyer
Congratulations Gary Strobel! The graduate students of APS cited Gary Strobel’s presentation on mycofumigation as the most fascinating talk of this year’s meeting. His work captured many peoples imagination. Besides Gary, our department presented research on endophytic bacteria, the lifecycle of powdery mildew of sugar beet, real-time PCR analysis of Fusarium populations and the application of plant pathogens for control of weeds. In addition, David Sands chaired a special session on retropathology (the use of plant pathogens for weed control) and Barry Jacobsen chaired a special session on Pseudomonads and their potential roles for control of plant diseases.

Now the meetings weren’t just work. In fact, little did I know getting off the plane in Austin, TX that I was in for one of the most enjoyable APS meetings ever? What an eventful meeting? Along with Nina Zidack, Gary Strobel, David Sands, Jack Ricsselman, Barry Jacobsen, and Andrew Hogg, we country line danced at the end of the session banquet, ate great food in the historic district, witnessed millions of bats swarming out from a local bridge at dusk, and even had a brief visit from our U.S. Attorney General, Alberto R. Gonzales (Of course...based on news reports ...the Bush sisters would have been a lot more interesting). Upon leaving Austin, I had a full mind, full stomach, tired legs, wide smile ....and a bunch of Jack’s knives that I had to get on the plane...

New Graduate Students
Jackie Campbell (Mike Giroux)

I was born, raised and educated in Denver, Colorado where the sun is always shining and the land is always under construction. I received my undergraduate degree in Biology from the University of Colorado in Denver in 2004. Upon graduation, I participated in a conservation botany project with the BLM in Southern Utah and then returned to Denver to work in Dr. L.P. Bruderele’s plant systematics lab at my alma mater.

I come to MSU in pursuit of an education in the practical and academic knowledge of the plant sciences as a Master's Degree student under the direction of Dr. Mike
Giroux. I hope this is a phase of burgeoning understanding for me in my primary interest of how plants work and interact with the world at large. My extracurricular interests include old cars, new chainsaws, fine food and even finer bluegrass. I am elated to be part of PSPP department and hope to fully appreciate the state as much as MSU.

Peng Liu (Bob Sharrock)

My name is Peng (pronounced Pung) Lu and I am here to pursue a Ph.D. in Plant Genetics with Dr. Bob Sharrock. I received my MS in Biochemistry & Molecular Biology from China Agricultural University this year and my B.S. in Plant Quarantine from Shandong Agricultural University in 2000.

I studied the biocontrol of sharp eyespot in wheat at Tobacco Laboratory in SDAU. Then my MS research focused on nRNA mechanism at state key laboratories for AgroBiotechnology. Now my research focuses on the Phytochrome structure and function. Our objective is to understand how the phytochrome red/far-red photoreceptors trigger and coordinate plant developmental responses to the light environment using molecular and genetic approaches.

In my free time, I like to play basketball, hike, read, and watch movies.

Vector/Virus Disease Workshop, Great Plains Diagnostic Networks Annual Meeting
By Jack Riesselman
MSU and the Department of Plant Sciences and Plant Pathology will host an insect vector/virus disease workshop and the Great Plains Diagnostic Networks annual meeting September 26-29th. Scientists from throughout the region will be in attendance. In conjunction with the event members of the Department are invited to a social and dinner on Wed, September 28th, from 5 to 7:30 pm in 209 and the Mathre Courtyard. To encourage attendance the following menu will be offered:

Seared London Broil with Green Peppercorn Sauce
Grilled Poached Champagne Dilled Salmon
Hutterite Riblets with Madison Junction BBQ Sauce
Manhattan Dutch Potato Salad

Clark Fork Valley Baked Beans
Celery Seed Cole Slaw Vinaigrette Salad
Yellowstone Valley Athena Sweet Cantaloupe with Yellow Clover Honey

Please RSVP to Irene so no one goes hungry – (5171 or decker@montana.edu)

To make the evening even more enjoyable an appearance by Montana's own Ringling Five is on the agenda. If you have not heard them, you’re lucky. But they will make you smile.

Grants
Sue Blodgett and Kevin O’Neill (LRES), USDA, CSREES, PMAP, ‘Designing Pest Management Strategies in Seed Alfalfa to Conserve Natural Enemies’.

Publications


Bob’s Byte
By Bob Johnston (Irene Decker filling in)

Tip #1: Copy a group of Excel cells into a Word document and make it good
1. Select your cells in Excel.
2. Copy (Ctrl+C).
3. In your Word document, on the Edit menu, click Paste Special.
4. Click Microsoft Office Excel Worksheet Object, and then click OK.

**Tip #2: Add a break from within a list**
Sometimes you want to add a note or a break from within list items, kind of like this:
- Here is the first item
- And here is the break.
- And here is the second item.
Rather than turning off the list and messing around with the margins, here is a quick and easy solution: Shift + Enter. That will maintain the margins, move the cursor on to the next line, and not generate a new bullet or number.

**#3 To create a zero with a slash through it**
1. On the Insert menu, click Field.
2. In the Field Names box, click Eq.
3. Click Field codes (toward the bottom of that dialog screen).
   Note: Do not click Equation Editor or you will be lost forever.
4. In the Field Codes box type EQ '0(0/)' . You can copy and paste that from here.
5. Click OK.
6. Now, select the slashed zero, right-click, and then click Toggle Field Codes.
7. Remove the extra space after the right parenthesis. Right-click again and click Toggle Field Codes.

The result should be a beautiful zero with a slash through it.

Here is how to create an AutoCorrect entry that will let you type in something that stands for the slashed zero and have the actual, slashed zero appear (without having to go through all that you did above).

**To create an AutoCorrect entry for a slashed zero**
1. Select the slashed zero in your document.
2. On the Tools menu, click AutoCorrect Options.
3. In the Replace box type whatever combination you want Word to turn into a slashed zero. An example is *0.
4. Click OK.

**Factors Affecting the Life and Quality of Cut Flowers**
By Bob Gough

**Temperature:**
Much of a plant's metabolism is highly dependent on temperature—the higher the temperature, the faster a process such as respiration proceeds, and the faster the plant uses up its internal food reserves. When a flower is cut from the plant, it has only the nutrients stored in its tissue upon which to live. So it makes sense to lower the temperature in order to slow the rate at which those nutrients are used up. The optimum temperature for handling most cut flowers is around 33 degrees Fahrenheit. This of course requires refrigeration, and it is difficult to enjoy and admire your flowers if they are in the refrigerator. So the best you can do on this account is to keep the vase of flowers in a cooler part of the room, out of direct sunlight and away from heat.

**Water:**
Flowers are mostly water and cut flowers depend upon the water in their vases to maintain their freshness. The water is conducted up through the flower stem by negative pressure (suction) created when some water evaporates from the leaf surface. If you can slow the rate of water loss through petals and leaves by increasing the relative humidity of the room to near 95%, then you will slow the rate of water use and reduce the potential for the flowers drying out. Maintaining room humidity at this level is very difficult, especially in our dry areas and in winter, when central heating reduces room humidity even more. So there is not much you can do about water lost due to relative humidity in your house. But you can pay attention to other concerns.

For example, the water moves from the vase through the stem in small tubes that make up the xylem tissue. When the flower is cut from the plant, air enters those tubes and forms tiny air bubbles called "air embolism". These can interfere with the stem's ability to move water from the vase to the flower. Therefore, always re-cut the flower stems beneath tepid water, removing about an inch of the stem to remove the embolisms and reestablish water flow. Flowers can take up water more easily when the acidity of the water is around pH 3.5, so a teaspoon or two of vinegar in the vase MAY help a bit. And again, always use tepid water at about 105 degrees Fahrenheit. Flowers also have difficulty taking up hard water, so a water softener will help with this, although it may make conditions worse for potted plants. Commercially available flower preservatives can also greatly increase the shelf life of your cut flowers.
Fresh Air:
Be sure the air in your house circulates freely. This will help remove the harmful gasses that can shorten the vase life of your flowers. Among the gasses most detrimental to cut flowers is ethylene. This is a naturally occurring plant hormone involved in ripening of fruit and senescence of plant tissues. Apples give off great quantities of this hormone as do many fruits and vegetables that are past their prime. It is also a compound found in high concentrations in vehicle exhausts and in smoke, say from a fireplace or wood stove. The effect of ethylene varies according to plant species, but the gas can cause premature wilting, early shattering, defoliation, and failure of the flower to open. So keep cut flowers away from apples and other fruit, especially those fruit that may be senescent and beginning to decay.

Pop and Candy Machines
For those of you who never take the elevator to the first floor, we don’t want you to live in ignorance of the fact that we have a candy and pop machine across from the elevator. Enjoy!

Recipe of the Month
Alaska Canned Salmon Carbonara
1 (14.75 ounce) can Alaska salmon, drained
8 ounces pasta, uncooked
6 slices bacon, diced
2 (14 ounce) cans diced tomatoes
1 cup chopped onion
3 tablespoons red wine vinegar
3 large cloves garlic, minced
2 teaspoons dried basil
1/2 teaspoon dried oregano
1/2 teaspoon coarse ground black pepper
1/4 teaspoon crushed red pepper
1/3 cup heavy cream
2 tablespoons finely grated Parmesan cheese

Break salmon into bite-sized pieces; set aside. Cook pasta according to package directions; drain and keep warm. In 3-quart saucepan, cook bacon until crisp. Drain, reserving about 2 tablespoons fat. Add tomatoes, onion, vinegar, garlic, basil, oregano and peppers. Cook 5 minutes or until slightly thickened. Stir in salmon pieces and cream; heat through.

Serve over hot cooked pasta. Garnish with cheese.

September Birthdays
Tracy Dougher 1
Debbie Willits 3